
This publication is intended to be used a supplement to the Arizona 
Rulemaking Manual and has been provided as a courtesy of the Public 

Services Division. 

If you find an error in this publication, please contact our Office at (602) 
542- 4086.

ELECTRONIC DOCUMENTS 

It starts with maintaining file structures. 

Come up with a plan; mark your documents 

with revision dates; take careful notes. 

Use your current rule text. Our Office calls 

this “base text” – your starting point. You can 

obtain this text from our Office. 

Read guidelines in this quick reference guide 

before your get started. Follow the 

guidelines, ask us questions. 

Use other tools that we provide. The Arizona 

Rulemaking Manual has everything you 

need to understand the process and it is 

available for free to rulewriters. Contact our 

Office for your copy.

simplifying RULE Documents 
A supplement to the Arizona Rulemaking Manual 

Public 
Services 
Division 

T H E  P R A C T I C E  O F  R U L E W R I T I N G

This booklet is designed for both 

the new and seasoned rulewriter.  

The important practices covered 

within these pages contribute to 

error-free rulemaking documents. 

We do not want to have the 

publishing of your filing delayed

because of formatting problems. 

Follow these guidelines. They can 

help you avoid having a 

rulemaking package returned, and 

will allow the Secretary of State 

editors to focus on searching for 

substantive errors. 

We are here to help. If you do not 

understand items presented in this 

booklet please call our Office. 

For a more in-depth look at 

rulemaking, consult the current 

edition of the Arizona Rulemaking 

Manual. 

WWW.AZSOS.GOV 1700 W. Washington St. 7
th
 Floor, Phoenix, AZ 85007  602.542.4086 
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MICHELE REAGAN 
Secretary of State 

Attention: Public Services Division 
1700 W. Washington Street, 7th Floor 

Phoenix, Arizona 85007

Visit us on the World Wide Web at www.azsos.gov 
e-mail: pubs@azsos.gov

The Office of the Secretary of State is an equal opportunity employer. Requests for alternate 
formats or accommodations can be made five days in advance by contacting the Secretary of 

State ADA Coordinator at (602) 542-4285. 
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Getting Started 
Personal accountability – as a rulewriter you are held accountable by your director, your 
stakeholders and to the public. No doubt about it, working on rules is a big responsibility. 

Additionally, one of our duties at the Secretary of State’s Office is to hold rulewriters 
accountable for their filings. Filings must fit within certain requirements. By following 
our rules often we protect the rulewriter and the agency which he or she represents. 

Our Office is here to help you understand the filing process of the rules – we cannot tell 
you what to put in them. Our Office is just a filing office, and as such, also has rules on 
rulemaking.  

The Arizona Administrative Procedures Act, the laws on rulemaking, is important for a 
beginning rulewriter to review. These are available online as part of the Arizona 
Administrative Code Table of Contents. Visit www.azsos.gov for more information. 

The Act or another part of the law may state that your agency is “exempt” from the 
rulemaking process or a part thereof. If this is the case we suggest you contact our Office 
before you get started so you file the correct type of notice. Please remember, just 
because you might be exempt from the process doesn’t mean you are exempt from our 
filing requirements.  

Once you have reviewed this booklet, please also read your Arizona Rulemaking Manual. 
It is more of a procedural manual with a style guide included. This guide is simply a 
supplement to the Manual. 

Rulemaking Docket Openings and Notices 

Examples of notices 

It’s helpful to use other agencies’ published notices as models for your own. To locate 
examples of different types of notices, go to the index printed in each issue of the 
Register and refer to past issues. Make sure to use the notice templates in the Rulemaking 
Manual.  

Often new rulewriters are concentrating on making new Sections or amending them. It is 
often overlooked that other Sections may have to be amended.  

To expedite the process, and to avoid filing additional docket openings for a rulemaking, 
an agency can enter the following language directly after the last listed Section 
numbering a docket opening: “Sections may be added, deleted, or modified as 
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necessary.” It’s not magic language, but this one phrase may just save some future 
procedural steps. 

And yes, if you leave out this language, you can file the additional docket opening and 
combine the two in your proposed rulemaking package. 

Accurate Base Text 
If it’s not right to begin with, it will be wrong later on. Sounds 
simple but you would be surprised how many rulewriters do not 
start with accurate text. 

An agency must accurately show the changes to the current rules in 
the Administrative Code. This is where you must start. Be sure to 

use the current effective rules in the Code as the base text from which to show changes. 

Retyping existing rules often introduces errors. The Office recommends that an agency 
download the RTF version of its rules from the SOS web site and alter the text from 
there.  

Please contact our Office if you are not sure which version of rules is the most current. 
You might have rules that will be updated in a Code supplement that has yet to be 
released. Be mindful of the base text that you are about to use. 

Setting up Your Electronic Document 
Computers, friend or foe? These guidelines will help make our pagination worry-free. 

Formatting Solutions 
Forget what you have learned about the word processing program. You must have the 
mindset to prepare and key everything in your document. Follow these steps when 
starting your electronic documents. 

Start Fresh 

� Open up a new document in your word processing. Set margins and always allow 
sentences of a single paragraph to wrap around automatically. Copy the base text from 
the Secretary of State web site. If you are not sure where to find the base text, call our 
Office.  
Why: There is less room for error if you start fresh. 



5 

Public 
Services 
Division 

A r i z o n a  S e c r e t a r y  o f  S t a t e

Number Your Pages 

� Consecutively number all pages of any rulemaking package filed with SOS. 
Why: The Office will know whether a page in your filing is missing. It also helps for 
future archiving of the document. 

Turn off Autoformatting; including Bulleting and Numbering 

�  Turn off autoformatting in your word processing program when creating a new 
document. You will have to manually key the A, B, Cs and the 1, 2, 3s into the document. 
Why: We ask that when you file your document you include an electronic version on a 
disk. If a document contains autoformatted text, the subsection numbers and letters 
disappear when the file is formatted in the Office’s publishing program. Autoformatting 
also inserts fraction symbols (½, ¾) and superscript ordinals (7th) that can disappear. 
Turning the autoformatting option off will prevent this from happening. 

In Microsoft Word, go to Format>AutoFormat... and click on “Options.” In the 
AutoFormat and AutoFormat As You Type tabs, make sure all of the boxes are not 
checked (leave them white). 

Track changes, reviewing, and conditional text 

� Turn off track changes, or reviewing, under the Tools menu in Word.  
Why: Files created with track changes cannot be imported properly into the Office’s 
publishing software. 

If you have Tools>Track Changes turned on in Word at any time during preparation of 
your rule package, the rule package you submit on disk will contain conditional text 
when the Office prepares it for publication. Conditional text is underlined or stricken, 
appears blue or red, and does not match the hard copy you submit to the Office. 
Significant inaccuracies can result from the use of these files, and the Office may delay 
publishing a rule package created with track changes or return the package to the agency. 

In Microsoft Word, go to Tools>Track Changes>Highlight Changes and make sure the 
boxes are not checked (remain white). 
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You say you have to use track changes? Our Office would still like a clean electronic 
document submitted.  

We understand that many hands may be in your document and that someone may insist 
that track changes be turned on. If it happens, accept the changes and do the following. 
Copy and paste from Word into Notepad. This will clear any formatting including the 
changes made in the program. You would then have to copy the text into your word 
processing program and reformat it to fit our filing requirements. It may sound 
cumbersome, but it is better than re-keying the entire document. 

Creating Tables 

�  When creating a table, make sure the rows of the table are connected rather than 
separated (each row should not be created as its own table). 
Why: The table will not import correctly into our publishing software. 

Endnotes and footnotes 

�  Do not use endnotes and footnotes in the Preamble or text of a rulemaking package. 
Why: The endnote and footnotes will not import correctly into our publishing software. 
The Code and Register do not have endnotes and footnotes in the rules. 

Exception to the Rule: 
Endnote and footnotes may be used as part of a table or other supplementary material, the 
Economic Impact Statement, and incorporated by reference material. 

Colored text 

�   Do not use colored text. Never use colored text as part of any notice filed with SOS. 
Why: The Office prints both the Register and the Code in black and white. 

Getting Down to Editing 
Have you imported your base text into your word processing program? Now you are 
ready to edit it. Here are a few simple guidelines to follow. 

Striking and Underlining 

Words or Numbers: Never strike or underline part of a word or number. 
Incorrect: Correct: 
dDepartment department Department 
R9-22-101102 R9-22-101 R9-22-102 
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A.R.S. § 28-10011201 A.R.S. § 28-1001 28-1201 

NOTE: There is never a reason to both strike and underline the same text in a rulemaking 
package filed with SOS. 

Subsection Labels and Periods: 
Incorrect: Correct: 
A.   A. 

 BA.   B.A. 

 CB.   C.B. 

To Tab or Not to Tab 

�    Tab, don’t space, after all subsection labels. 
Correct: 

A.TAB�
1.TAB�

a.TAB�
i.TAB�

It is acceptable if your paper or electronic copy has tabs that are underlined or stricken. 

Hard Returns 

When typing a sentence, do not use a hard return until you are ready for a new paragraph. 
Only hit return (or “enter”) to separate paragraphs or subsection levels.  

Avoid using more than four subsection levels. Yes, the Office would prefer that you do 
not use them. We can offer assistance to show you how. 

If you have to use more than four, the following labels apply: 
A. (level 1)
B. 

C. 

1. (level 2)
2.
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3. 
a. (level 3)
b.
c.

i. (level 4)
ii.
iii.

(1) (level 5)
(2)
(3)

(a) (level 6)
(b)
(c)

Formatting Your Document 
These are the most common errors that the Office sees in filed documents. 

Page number references 

�   Never refer to a part of your rulemaking package by its page number location.  
Why: The page numbers of the copy filed with SOS will be different when published in 
the Register and Code. 

Spacing and Typing 101 

�   Never use two spaces after a period, colon, or state abbreviation.  
Why: Computers, unlike typewriters of the past, adjust character spacing so that a 
double-space is not needed to make readers understand that they have reached the end of 
the sentence.  
Also, don’t space after all subsection labels and notice form item numbers, use tabs (see 
the tabs section below). 

There is one exception to this rule. The headings for supplementary material (such as 
Appendices, Illustrations, Exhibits, Tables, etc.) should be indented two spaces from the 
left in the Table of Contents. 
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Special Symbols 

Many times special symbols do not translate properly when imported into the SOS 
desktop publishing program.  
Why: The publishing software may misinterpret the symbol or drop it out when 
imported. 

It’s helpful to the Office if you mark the pages of a rulemaking package with sticky notes 
that contain subscript and superscript text and special symbols (such as ×, £, Š, m, ±, 
etc.). 

Quotation marks 

�   Follow these long-established American printers’ rules: 
� The period and the comma always go within the quotation marks. 
� The dash, the semicolon, the question mark, and the exclamation point go within 

the quotation marks when they apply to the quoted matter only. They go outside 
the quotation marks when they apply to the whole sentence. 

� The exception is when a single item enclosed in quotation marks is just a number 
or letter. (“The applicant may sign her name with an “X”.) 

Citations, a Final Check 

�  Once you have completed the editing of your rules remember to verify that Sections 
and subsections referred to in a rule actually exist. Many times after renumbering or 
amending rules, citations to other Sections or subsections need to change. 

An agency can make these corrections by normal rulemaking or by sending the Office a 
letter requesting the changes (A.R.S. § 41-1011(C)). 

Forms and Preambles, the Final Stage 

Understanding Your Actions 
There are rulemaking actions and those actions must be understood when creating your 
Table of Contents. The rulemaking action intended by an agency must be accurate in the 
Preamble, Table of Contents, and text of the rules. It matters because the rulemaking 
action is reflected in the Administrative Code Historical Note and the index of the 
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Register. The types of rulemaking action listed in the Preamble are the following: Repeal, 
Renumber, Amend, and New Section (or Article, Table, Exhibit, etc.). The maximum 
number of actions on a Section is three, taken as applicable in this order: Repeal, 
Renumber, Amend, New Section. Remember that a Section number and its heading will 
always look the same in the Table of Contents as they do in the text of the rules. 

 
Avoid renumbering whenever possible. Agencies understandably use renumbering to 
“clean up” their rules, but the Office has found that renumbering frequently proves to be 
time-consuming and can introduce errors. If the intended result of the renumbering is 
merely cosmetic, SOS prefers that the agency not do it. (See Section 3 of the Arizona 
Rulemaking Manual for examples.) 

Filing Preparation 

Accuracy and Neatness Counts 
�    Receipts and certificates should match and the filing notice should match the receipt 
and certificates. Sections listed in these documents should match. 
Why: The most common filing errors are on receipts and certificates. Avoid having the 
incorrect notice or Section number and avoid going to your boss for another signature on 
a certificate. Double-check your work. These all must match to protect your agency from 
potential lawsuits. 

 
The most common way this error happens is when you “cut and paste” text from one 
document to another (e.g., notice headings and headings for agency receipts and 
certificates). If you cut and paste simply make sure that all the information is correct.  
 
To Tab or Not to Tab, Again 
�    Tab, don’t space, after all notice form item numbers. 
3. TAB� A citation to all published notices relating to the proceeding: 
 
Returns 
When providing information for notice forms, hit return at the end of an item number and 
begin the “answer” on the next line. 
Incorrect:  
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3.  A citation to all published notices relating to the proceeding: Notice of 
Proposed Rulemaking: 9 A.A.R. 4811, November 7, 2003 
 
Correct: 
3. A citation to all published notices relating to the proceeding: 

 Notice of Proposed Rulemaking: 9 A.A.R. 4811, November 7, 2003 
 
Item numbers references 
Refer to the numbered sections on notice forms as “items” instead of “questions.”  
Correct: A person may submit written comments to the analyst listed in item 4. 
 
 
Save to RTF 
Save your rule package as a Word or WordPerfect document, but also as an RTF file. If 
the Office cannot open the Word or WordPerfect file on your disk, it’s helpful to have an 
RTF version as a backup. 

 
�   Spell check. Always remember to spell-check a rule package before filing it with 
SOS. 
 
 
Double Check Receipts and Certificates BEFORE They are Signed.  
Receipts and certificates should match and the filing notice should match the receipt and 
certificates. Sections listed in these documents should match. Check these items before 
your agency head signs the certificate. 

Time-Frames, Deadlines and Effective Dates 

The Close of Public Record 
Remember that closing the public record starts the clock on the 120-day time-frame for 
submitting the final rule package. The close of public record for a proposed rulemaking is 
the date an agency chooses as the last date it will accept public comments on the rule 
package. An agency cannot make a rule until the rulemaking record is closed (A.R.S. § 
41-1024(A)). 
 
Within 120 days after the close of record, an agency must either submit the rule package 
to G.R.R.C. or the Attorney General, or terminate the rulemaking.  
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Most agencies do not publicly announce the close of record because of the 120-day time-
frame, and instead allow the act of submitting the rule package for approval to be the 
close of record. 

Register Deadlines 
The Secretary of State’s Office publishes the Register weekly. BUT, there is a three-week 
turnaround period between a deadline date and the publication date of the Register. 
Publishing dates are published in the back of the Register. 

Code Deadlines 
The Secretary of State’s Office publishes updates to the Arizona Administrative Code 
four times a year. See the back of the Register for supplement release dates. 

Rule Effective Dates 
A.R.S. § 41-1032(A) states that a rule generally becomes effective 60 days after the day it 
is filed with the Secretary of State’s Office. There are of course, exceptions to this rule. 
Refer to the Administrative Procedures Act. 

It’s Not Over Yet 

Your Responsibility After Filing 
Our editor’s strive for accuracy in our publications, but sometimes mistakes are made. 
Please compare your published notice with your paper copy. If the error is ours we will 
correct it. 
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This area has been provided for your notes



Helpful Phone Numbers: 
Secretary of State’s Office, Public 
Services Division editors: 
(602) 542-4751

Governor’s Regulatory Review Council: 
(602) 542-2058
www.grrc.state.az.us
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